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Welcome to Hot Door CADtools, plug-in tools
which provide precision drawing and dimensioning
power within the flexible vector illustration environ-
ment of Adobe Illustrator 7.0. This manual contains
detailed information about CADtools palettes,
tools, and preferences added to Illustrator 7.0.
This user guide applies to both Macintosh® or
Windows® 95 and NT 4.0 versions of Hot Door
CADtools. This user guide also assumes you have
working knowledge of the operating conventions of
the Macintosh or PC running Windows and Adobe
Illustrator 7.0.
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Installing & registering
CADtools

Macintosh Installation
To install CADtools on your Macintosh, follow
these steps:

1. If you are currently running Adobe Illustrator 7.0,
quit the application.

2. On your drive, locate the Tools folder inside the
Plug-ins folder inside your Adobe Illustrator®

7.0 folder. Insert the CADtools floppy diskette into
the floppy drive. Copy the file named CADtools
from the floppy diskette to the Tools folder on your
drive.

3. When you launch the Adobe Illustrator 7.0
application again, you should see some of the tools
belonging to CADtools appear in the toolbox.
CADtools icons are distinguished by their red point
markings.

Windows Installation
To install CADtools for Windows, follow these
steps:

1. If you are currently running Adobe Illustrator 7.0,
quit the application.

2. On your drive, locate the Tools folder inside the
Plug-ins folder inside your Adobe Illustrator®

7.0 folder. Insert the CADtools floppy diskette into
the floppy drive. Copy the file named
CADtools.aip from the floppy diskette to the
Tools folder on your drive.

3. When you launch the Adobe Illustrator 7.0
application again, you should see some of the tools
belonging to CADtools appear in the toolbox.
CADtools icons are distinguished by their red point
markings.
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Installing & registering
CADtools (cont.)

To be eligible for free technical support, information
on upgrades, and other special offers, please
register your copy of CADtools. To register,
complete and mail this form, or the registration
card attached to your CADtools reference card to:

Hot Door
P.O. Box 3841
Long Beach, CA  90803
USA

or FAX: 562-438-8686

CADtools registration card

Serial Number: ______________________________ Date purchased: ______________________
(located on the sticker on the CADtools program disk)

Name: ___________________________________________________________________________

E-mail: ___________________________________________________________________________

Company:_________________________________________________________________________

Street Address: ____________________________________________________________________

City: _____________________________________________ State/Province: __________________

Zip/Postal Code: _______________ Country: __________ Phone: __________________________

Where did you purchase CADtools:

__________________________________________________________________________________

What is your organization’s primary business?

__________________________________________________________________________________

What is your primary job function?

__________________________________________________________________________________
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Where to find help with
CADtools

This user guide
This user guide is in pdf format which can be
viewed and printed with Acrobat Reader 3.0 which
is located on your Adobe Illustrator 7.0 cd.

The quick reference card
The quick reference card included in your CADtools
software product box lists the function and location
of each tool belonging to CADtools. The card also
describes the CADtips palette, CADtracker palette,
and CADtools preferences. A tool reference is also
located in Appendix A of this manual.

On-screen help
From the Adobe Illustrator 7.0 menu bar, choose
Windows > CADtools > Show CADtips.
CADtips will display step-by-step instructions for
using any tool belonging to CADtools. To begin
viewing CADtips, select one of the tools belonging
to CADtools. CADtools icons are distinguished by
their red point markings.

On-line FAQ
Frequently asked questions about CADtools
are answered on the CADtools web site at
http://www.hotdoor.com/CADtools/

E-mail technical support for registered users
If you complete and return the registration form
included in your CADtools software product box,
you are entitled to free e-mail technical support.
If you are registered as a CADtools user on
Macintosh, please send e-mail questions to
CADtoolsmac@hotdoor.com. If you are regis-
tered as a CADtools user on Windows, please send
e-mail questions to CADtoolswin@hotdoor.com

Phone technical support for registered users
If you complete and return the registration form
included in your CADtools software product box,
you may receive CADtools technical support by
calling 562-438-4443 or faxing 562-438-8686.
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Overview of the CADtools
interface

Finding all the tools
After you have properly installed CADtools and
launched Adobe Illustrator 7.0, you will notice new
CADtools drafting and dimensioning tools in the
toolbox of Adobe Illustrator 7.0.

In addition to the four new tools you see in the
toolbox, there are many hidden tools. Select the
small arrows on the right of the tool icons and drag
to highlight other tools. You will find CADtools
drafting and editing tools by selecting and drag-
ging from the pen, ellipse, rectangle, pencil, and
scissors tools. CADtools dimensioning tools can be
accessed by selecting and dragging on any of the
four visible dimensioning tools near the bottom of
the toolbox.

Color icons and tool behavior
CADtools icons are distinguished by their red point
markings. The red points indicate the position
of mouse-click(s) in relationship to the artwork
created. Tool icons which have only one red point
require only one mouse-click-and-drag – except for
the circle center tool, which requires only one
mouse-click on a circle. Tool icons which have two
red points require two mouse-clicks positioned on
artwork as shown in the icon. For most of these
tools, you must drag the mouse after the second
click. The fillet, chamfer, trim, and wall healer tools
do not require dragging after the second click.

Locating CADtools preferences
CADtools preferences can be opened by choosing
File > CADtools Preferences... CADtools
Preferences allow you to adjust your general
drafting specifications, appearance of dimension
lines, terminators, and text, and settings for your
drafting and editing tools.

Hot Tip!
The CADtools icons all contain red
points which indicate the number and
placement of mouse-clicks required to
properly use the tool.

Many CADtools icons are
hidden behind related tools in
the toolbox.
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Overview of the CADtools
interface (cont.)

Displaying CADtools palettes
CADtools adds two new palettes to lllustrator 7.0:
CADtips and CADtracker. These palettes can be
opened by choosing Windows > CADtools >
Show CADtips or > Show CADtracker.

CADtips displays step-by-step instructions while you
are using any tool belonging to CADtools. To begin
viewing tips in the CADtips palette, select one of the
drafting and dimensioning tools in the toolbox.

While using CADtools drafting tools, the CADtracker
palette displays object information in the current
scale, units, and precision specified in CADtools
Preferences. CADtracker displays width, height,
circumference, perimeter, area, angle, line length
and the current scale. CADtracker also displays
scaled width and height of any selected object in
Illustrator. CADtracker docks to any palette within
Illustrator to help you organize your desktop.

Numeric input
You can create artwork to scale by numerically
specifying dimensions for CADtools drafting tools.
Select any of the CADtools ellipse, rectangle, line or
wall tools and click once where you want to begin
creating the shape. If you are using a centered tool,
your click location will define the center of the ob-
ject; otherwise, the click location will define a corner
of the object.

A numeric input dialog box will appear, displaying
the dimensions you last specified for that tool. The
units of measure are determined by the settings in
CADtools Preferences. Enter values and units in the
text boxes, using one of the unit abbreviations listed
below:
1) points: pt
2) picas: p
3) millimeters: mm
4) centimeters: cm
5) inches: in or “
6) feet: ft or ‘
7) feet and inches: ft – in or ‘ – “

(Example: 1 ft – 3 1/2 in or 1’ – 3.5”)

Hot Tip!
CADtips and CADtracker can dock to any
palette in Illustrator to help you organize your
desktop. To dock a palette, drag the palette
tab of one palette to the bottom of another
palette.
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Overview of the CADtools
interface (cont.)

Keyboarding for precision and shortcuts
CADtools utilizes the shift, alt/option, and control
keys to give you more control and flexibility while
drafting and dimensioning. Note: these keys only
function if you hold them down after you select and
begin drafting or dimensioning with one of the tools.

Use the shift key to constrain most CADtools
drafting and dimensioning tools to multiples of
45 degrees.

To quickly switch between certain tools in CADtools,
use the alt/option key (alt for PC and option on
Macintosh) while dragging to toggle between the
following tools:
1) rectangle and centered rectangle
2) ellipse and centered ellipse
3) arc (by radius) and arc (by endpoints)
4) horizontal dimension by point and vertical

dimension by point
5) horizontal dimension by line and vertical

dimension by line
6) radius and diameter dimension

Use the control key for variations in dimensioning
artwork. The control key provides the following tool
variations:
1) arc: complementary arc
2) section line: adjacent placement of label
3) angle dimension: complementary angle
4) arc length dimension: complementary arc length
5) diameter dimension: adjacent placement of label
6) radius dimension: adjacent placement of label
7) Bézier curvature dimension: arc visibility
8) all label tools: adjacent placement of label

To remove witness lines while drawing angle dimen-
sions, use the alt/option key while dragging with
the angle dimension tool.

Using the control key for variations

Angle dimensioning without control key

Angle dimensioning with control key

Hot Tip!
To use the keyboarding enhancements,
hold down the shift, alt/opt, and control
keys after you click and begin dragging
with CADtools drafting or dimensioning
tools.

322°

38°
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Overview of the CADtools
interface (cont.)

Cursor feedback
While you are drafting and dimensioning with
CADtools, you will receive additional precision
cursor feedback to help you select lines and anchor
points in the correct order.

precision cursor
over path

precision cursor
over anchor point

precision cursor
waiting for second click

cursor dragging to
create artwork

(optional)
cursor over
dimension line

CADtools drafting or dimensioning tool is selected and cursor is directly
over a path

CADtools drafting or dimensioning tool is selected and cursor is directly
over an anchor point

CADtools drafting or dimensioning tool is selected, you have already
clicked once, and you need to click or click-drag to create artwork

CADtools drafting or dimensioning tool is selected, you have clicked
once or twice, and you are dragging

Allow dimensions off of dimensions is unchecked in CADtools
Preferences, a CADtools dimensioning tool is selected, and you are
directly over a dimension line. You will not be able to create a dimension
when this cursor appears.

precision cursor CADtools drafting or dimensioning tool is selected

Cursor description Activity status
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Setting CADtools
preferences

Locating CADtools preferences
CADtools preferences can be opened by double-
clicking any tool belonging to CADtools or choosing
File > CADtools Preferences... Select one of the
five preference panels by using the pop-down menu
at the top of the CADtools Preferences dialog box.
You can also navigate through the preference panels
by clicking Next or Prev. At any time you may click
OK and your CADtools Preferences will close and be
saved.

1) General
• Scale affects how your drafted artwork is
measured in the CADtracker palette, CADtools
numeric input dialog box, and Drafting Tools Prefer-
ence panel in CADtools Preferences. While drafting
in scale, use the CADtracker or numeric input to
accurately draw artwork at a reduced or enlarged
size to fit on your page. Note: CADtools scale will not
affect measurements displayed in the Illustrator Info
palette.

To set scale, select the pop-down menu and choose
an enlarged or reduced preset scale or Custom Scale.
If you select Custom Scale, enter any scale in the field
located to the right of the Scale menu. Enter the scale
in the format shown – numbers separated by a colon.

Note: CADtools scale does not automatically enlarge
or reduce your artwork – it affects how your drafted
artwork is measured in the CADtracker palette, nu-
meric input dialog box, and Drafting Tools preference
settings. To enlarge or reduce your artwork, use the
scale tool within Adobe Illustrator 7.0.

• Units are set by selecting the Units pop-down
menu and choosing from several standard units. Any
of these units may be used when specifying dimen-
sions with the CADtools numeric input dialog box or
Drafting Tools preferences.

 • Precision is set by selecting the Precision pop-
down menu. Choose from one to five decimal
precision places or from 1/2 to 1/256 when using
fractional units.

reduced scales

enlarged scales

Hot Tip!
To open CADtools Preferences without
using the menu, double-click any tool
belonging to CADtools.
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Setting CADtools
preferences

2) Dimension Lines
The Dimension Lines Preference panel allows you to
set the appearance of your dimension lines.

• Create and use dimension layer will draw
your dimension lines in a separate layer named
“Dimension Layer”. This layer can be hidden,
locked, displayed, and printed like other layers
created within Illustrator 7.0.  Note: If you rename
the “Dimension Layer”, another layer named
“Dimension Layer” will be created.

• Draw dimensions in black will ignore the
current paint style settings and allow you to always
create black dimension lines and text. Stroke weight
for your dimension lines will remain defined by the
settings in the stroke palette.

• Allow dimensions off of dimensions will
allow you to dimension lines originally created with
the dimensioning tools in CADtools. When this
option is unchecked, you will see (      ) when you
move the cursor over dimension lines, and you will
not be able to dimension those lines. You may want
to uncheck this option when working with many
dimension lines on a page.

• Double stroke weight of section line will
automatically draw your section lines at double the
stroke weight set in the stroke palette.

• Automatic dimension offset value is the offset
increment to which your dimension will snap from
the object line while you are dragging with the shift
key down. This feature will allow you to maintain
consistency in dimension line placement.

• Witness line gap value is the distance between
the object line and the witness line.

• Witness line extension value is the distance
that the witness line extends beyond the dimension
line.

appears if you uncheck
“Allow dimensions off
of dimensions” in
CADtools Preferences

witness line
gap

witness line
extension

automatic
dimension
offset

Hot Tip!
You can avoid mistaking dimension lines for
artwork by unchecking “Allow dimensions off
of dimensions”. When this option is un-
checked, you will see (      ) when you move
the cursor over dimension lines, and you will
not be able to dimension those lines.
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Setting CADtools
preferences

3) Dimension Terminators
The Dimension Terminators Preference panel allows
you to adjust the appearance of your dimensioning
terminators. Select one of the four buttons on the
left and then enter values to fine-tune your selection.

• Arrowhead length and angle values will
fine-tune the arrowhead appearance if the arrow-
head terminator option is selected.

• Circle diameter value will adjust the size of the
circle terminator if it is selected.

• Slash length value will set the length of the
slash terminator if it is selected.

4) Dimension Text
The Dimension Text Preference panel allows you to
control the placement and appearance of dimension
text. Select one button from each of the three pairs to
set the placement of horizontal, vertical, and incline
dimension text.

• Text distance above the line value defines the
gap between the dimension text and line.

• Stroke dimension text option will stroke
dimension text with your current stroke style settings.
Note: when this option is unchecked, CADtools ignores
the stroke setting when creating dimension text.

• Append unit labels after all dimensions
option will place the unit after the dimension text.

• Place      <Before> or <After> diameter
dimension option will allow you to adjust the
placement of       in the diameter dimension text.

• Place “R” <Before> or <After> radius
dimension option will allow you to adjust the
placement of “R” in the radius dimension text.

text distance
above the line

stroked
dimension text

appended unit
label

28.5 in

52.5 mm52.5 mm52.5 mm52.5 mm52.5 mm

      before diameter dimension

arrowhead length

arrowhead
angle
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Setting CADtools
preferences

5) Drafting Tools
The Drafting Tools Preference panel allows you to
set drafting and editing measurements. Enter values
for actual size, since the values automatically scale
according to the current scale displayed in the
CADtracker palette. Also enter a unit of measurement
which is supported by CADtools, including pt, p, mm,
cm,  in or “, ft or ‘, ft – in or ‘ – “.
(Example: 1 ft – 3 1/2 in or 1’ – 3.5”)

• Wall thickness value sets the width of your walls.

• Fillet radius value sets the radius of any fillet you
create by clicking on two lines with the fillet tool.

• First click chamfer offset value is the distance
between the intersection of two lines and the point on
the first line that you click with the chamfer tool. The
point becomes an endpoint of the chamfer.

• Second click chamfer offset value is the distance
between the intersection of two lines and the point on
the second line that you click with the chamfer tool.
The point becomes an endpoint of the chamfer.

wall thickness

fillet radius

first click chamfer offset
(if this line is clicked first)

second click chamfer
offset (if this line is
clicked second)
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Using CADtools for
drafting

The CADtools drafting tools allow you to precisely
create artwork by using numerical input or measure-
ments displayed in the CADtracker palette.

Ellipse
Select the CADtools ellipse tool and position the
cursor where you want a corner of the ellipse to
appear. Click and drag from one edge of the ellipse
to the opposite edge. Hold down the shift key while
dragging to create a circle.

Note: To quickly toggle between ellipse and
centered ellipse, use the alt/option key. To numeri-
cally create an ellipse to scale, click once with the
CADtools ellipse or centered ellipse tool.

Centered ellipse
Select the CADtools ellipse tool and position the
cursor where you want a corner of the ellipse to
appear. Click and drag from the center of the ellipse
to the edge. Hold down the shift key while dragging
to create a circle.

Arc (by radius)
Select the arc tool and position the cursor where you
want the center of the arc. Click the mouse button
once and release the mouse button. Position the
cursor where you want the arc to begin, which will be
the length of the arc radius. Click and drag counter-
clockwise to create the arc. Hold down the control
key while you are dragging to create the opposite
angle.

Note: To quickly toggle between arc (by radius) and
arc (by endpoints), use the alt/option key.

Arc (by endpoints)
Select the arc tool and position the cursor where you
want the arc to begin. If this is an anchor point, the
cursor will change to (      ). Click the mouse button
once and release the mouse button. Position the
cursor where you want the arc to end. Click and
drag back and forth to create the arc. Hold down the
control key while you are dragging to create the
opposite arc.

○

○

○

○

○

○

○

○

○

○

first
click

second
click then drag
counterclockwise

first
click

second
click then drag
back and forth

○

○

○

○

○

first click then drag

first click then drag
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Using CADtools for
drafting (cont.)

Rectangle
Select the CADtools rectangle tool and position the
cursor where you want a corner of the rectangle to
appear. Click and drag from one edge of the rect-
angle to the opposite edge. Hold down the shift key
while dragging to create a square.

Note: To quickly toggle between rectangle and
centered rectangle, use the alt/option key. To
numerically create a rectangle to scale, click once
with the CADtools rectangle or centered rectangle
tool.

Centered rectangle
Select the CADtools rectangle tool and position the
cursor where you want a corner of the rectangle to
appear. Click and drag from the center of the rect-
angle to the edge. Hold down the shift key while
dragging to create a square.

Line
The CADtools line tool allows you to see the line
while you are dragging to create it. Using the
CADtracker palette, you can also monitor the angle
of the line while you are creating it.

Select the line tool and position the cursor where you
want the beginning of the line to appear. Click and
drag to position the line, then release the mouse but-
ton to create the line. Hold down the shift key while
dragging to constrain the tool to multiples of 45°.

To create polygons with the line tool, create a line,
then position your mouse over an endpoint of the
line. When the (      ) cursor appears, begin dragging
to create a new line joined at that endpoint. Release
the mouse button when you have positioned the line
and continue the process as needed. If you want to
close the path, click and drag the final line until the
cursor is over the first anchor point of the polygon.
When the (      ) cursor appears, release the mouse
button and the polygon will close itself.

Note: To numerically create a line to scale, click once
with the CADtools line tool.

first click then
drag

○

○

○

○

○

first click then drag

○

○

○

○

○

○

○

○

○

○

○

○

○

first click then drag
○

○

○

○

○

○

○

○

○

○

first click then drag

○

○

○

○

○

○

○

○

○

release mouse
button, click point,
then drag

○

○

○

release mouse
button, click point,
then drag

○ ○ ○ ○ ○ ○ ○ ○ ○
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Using CADtools for
drafting (cont.)

Wall
The CADtools wall tool works much like the line
tool, creating rectangles (representing walls) with a
thickness defined in the Drafting Tools Preference
panel in CADtools Preferences.

Select the wall tool and position the cursor where
you want the end of the wall to appear. Click and
drag to position the wall. Release the mouse button
to create the wall. Hold down the shift key while
dragging to constrain the tool to multiples of 45°.

To create an additional wall joined to the end of an
existing wall, click on the end of a wall and begin
dragging. Release the mouse button when you
have positioned the wall and continue the process
as needed. If you are creating a wall path and
want to close the path, drag the final wall segment
until the cursor is over the beginning of the wall
path. When the (      ) or (      ) cursor appears,
release the mouse button and the wall path will
close itself.

Note: If you want to heal multiple or intersecting
walls, use the wall healer tool to select and heal the
walls. To numerically create a wall to scale, click
once with the CADtools wall tool.

first click then drag

○
○

○
○

○
○

○
○

○
○

○
○

first click then drag

○
○

○
○

○
○

○
○

○

○

○

○

○

○

○

○

○

○

○

○

release mouse
button, click point,
then drag

To heal intersecting
walls, use the wall
healer tool

Hot Tip!
To open CADtools Preferences without
using the menu, double-click any tool
belonging to CADtools.

Hot Tip!
Use the wall tool to easily create
borders or frames on your documents.
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Using CADtools for
drafting (cont.)

Using CADtracker while you are drawing...

X

Y

W

H

Length
for lines and walls

Diameter
for circles

Radius
for circles
and arcs

Perimeter
for rectangles
and ellipses

Circumference
for circles

Arc Length

Area

Horizontal distance of cursor from 0 point
on the ruler

Vertical distance of cursor from 0 point on
the ruler

Horizontal width of the artwork created

Vertical height of the artwork created

Angle between the first click point and the
current mouse location

Distance between the first click point and
the current mouse location

Diameter of the circle you are drawing

Radius of the circle or arc you are
drawing

Distance around a non-circular path

Distance around a circular path

Distance around the circular arc between
two endpoints you have defined

Area of rectangles, centered rectangles,
ellipses, centered ellipses, and arcs

Using CADtracker with artwork selected...

X

Y

W

H

Length
for any open path

Perimeter
for any closed path

Horizontal distance of object from 0 point

Vertical distance of object from 0 point

Horizontal width of the artwork created

Vertical height of the artwork created

Total distance along the path

Total distance around the closed path
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Using CADtools for
editing

Fillet
The fillet tool allows you to create a fillet between
two intersecting lines or a corner. The fillet radius
is set in the Drafting Tools Preference panel in
CADtools Preferences.

Select the fillet tool and position the cursor over
one of two intersecting lines which you plan to fillet.
When the (      ) cursor appears, click once on the
line, then position the cursor over the second
intersecting line. When the (      ) cursor appears,
click once on the second line to create the fillet.

Chamfer
The chamfer tool allows you to create a chamfer
between two intersecting lines or a corner. The
chamfer length is determined by the distance
between the chamfer endpoints and the corner or
intersection. These distances – chamfer offsets –
can be set in the Drafting Tools Preference panel in
CADtools Preferences.

Select the chamfer tool and position the cursor over
one of two intersecting lines which you intend to
chamfer. When the (      ) cursor appears, click
once on the line, then position the cursor over the
second intersecting line. When the (      ) cursor
appears, click once on the second line to create the
chamfer.

first click

second click

first click

second click

Hot Tip!
To open CADtools Preferences without
using the menu, double-click any tool
belonging to CADtools.
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Using CADtools for
editing (cont.)

Trim
The trim tool will automatically delete the excess
portion of two intersecting lines. Select the trim tool
and position the cursor over the excess portion of
one of the intersecting lines. When the (      ) cursor
appears, click once on the line, then position the
cursor over the excess portion of the second line.
Click once on the second line to eliminate both
excess portions and create a corner intersection.

Wall healer
The wall healer tool will unite two walls or wall
paths which intersect. Select the wall healer tool
and position the cursor over one of the intersecting
walls. When the (      ) cursor appears, click once
on the wall, then position the cursor over the
second intersecting wall. When the (      ) cursor
appears, click once on the second wall and both
walls or wall paths will unite.

Note: You cannot heal walls which are already
composed of multiple or compound paths. To heal
wall paths which are compound paths, select both
wall paths and select Object > Pathfinder > Unite.

For complex layouts requiring many intersecting
compound wall paths, avoid closing your wall
paths. For best results, use the wall healer on
intersecting wall segments and paths which are not
closed.

first click

second click

first click

second click

Wall paths which are made of multiple com-
pound paths cannot heal with the wall healer tool

Simple wall paths can heal with wall healer tool

Hot Tip!
To “heal” compound paths, use Illustrator’s
“Unite” filter.
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Using CADtools for
dimensioning

The dimensioning tools in CADtools allow you to
express detailed information about shapes, objects,
and spaces through the conventional use of lines,
symbols, and text. The CADtools dimensioning tools
work with any vector artwork within Adobe Illustrator
7.0. With Adobe Illustrator 7.0, you can also open
files created by many other applications. Vector
artwork in the document you open becomes Illustra-
tor paths that you can dimension with CADtools.

Note: Dimension lines and symbols that are created
with CADtools are vector artwork, and can be
selected, moved, and modified within Illustrator.
The numerical measurements are not linked to the
artwork being measured or the dimension lines
created.  If the artwork is modified after
you have dimensioned it, the original
dimension lines and measurements may
not be accurate. To insure accuracy, delete any
original dimensions which describe the modified
artwork, then re-dimension the modified artwork.

Once you have created a dimension or label with
CADtools, it is grouped as artwork. To select,
move, or modify the dimension artwork without
ungrouping it, use Illustrator’s direct-selection
tool (      ). To edit text, use the text tool (      ).

The dimensions are placed on a Dimension Layer
within Illustrator if you have checked this option in
the Dimension Lines Preference panel in CADtools
Preferences. You can lock or hide this layer to work
with other artwork without affecting the dimensions.

You can also dimension off of other dimension lines
if you have checked this option in the Dimension
Lines Preference panel in the CADtools Preference.
If this option is checked, you will be able to dimen-
sion from points or lines of circle centers, datum
flags, and other dimensioning artwork. If this option
is unchecked you will see the (     ) cursor over
dimension lines and you will not be able to dimen-
sion them.

Hot Tip!
Since CADtools dimension lines are placed on
their own Dimension Layer, hide or lock this
layer to easily work with artwork on other
layers.
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Use the CADtools Preferences to adjust the
appearance of your dimension lines, terminators,
and text before you dimension your artwork.
Note: Your preferences will not adjust your
dimensions after they have already been created.

To set the dimension line and text color, use the
paint style palette in Adobe Illustrator 7.0. The fill
box controls the dimension text color and the stroke
box controls the dimension line color. To set the
stroke weight use the Stroke palette. Note: If you
plan to use black dimension lines and text, check
“Draw dimensions in black” in the Dimension Line
Preferences panel in CADtools Preferences. “Draw
dimensions in black” will ignore the current paint
style settings and allow you to always create black
dimension lines and text. Only stroke weight for
your dimension lines will remain defined by the
settings in the stroke palette.

Horizontal dimension (by line)
The horizontal dimension (by line) tool will
dimension horizontal line segments. A line
segment is a straight path between two anchor
points in Illustrator.

Select the horizontal dimension (by line) tool and
position the cursor over the line you want to
dimension. When the (      ) cursor appears, click
the horizontal line and drag to position the dimen-
sion line. Hold down the shift key while dragging to
offset the horizontal dimension line in increments.
The offset increment value is set in the Dimension
Line Preference panel in the CADtools Preferences.

Note: To quickly toggle between horizontal
dimension (by line) and vertical dimension (by line),
use the alt/option key.

first click
then drag ○

○

○

○

Hot Tip!
Create consistently placed linear dimension
lines by holding down the shift key while
dragging dimension lines. This will offset the
dimension lines at an increment set in the
Dimension Line Preference panel in CADtools
Preferences.

Hot Tip!
Avoid adjusting dimension line and text paint
attributes by checking “Draw dimensions in
black” in the Dimension Line Preferences panel
in CADtools Preferences. “Draw dimensions in
black” will ignore the current paint style settings
and allow you to always create black dimension
lines and text.
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Horizontal dimension (by points)
The horizontal dimension (by points) tool will
dimension the horizontal distance between any two
points. You define the location of these two points
anywhere on your document.

Select the horizontal dimension (by points) tool and
position the cursor at one end of the horizontal
distance you want to dimension. If this is an anchor
point, the cursor will change to (      ) . Then click
the mouse button once and release the mouse
button. Position the cursor at the opposite end of
the horizontal distance you want to dimension. If
this is an anchor point, the cursor will change to
(      ) . Then click and drag to position the dimen-
sion line. Hold down the shift key while dragging to
offset the horizontal dimension line in increments.
The offset increment value is set in the Dimension
Line Preference panel in the CADtools Preferences.

Note: To quickly toggle between horizontal
dimension (by points) and vertical dimension (by
points), use the alt/option key.

Vertical dimension (by line)
The vertical dimension (by line) tool will dimension
vertical line segments. A line segment is a straight
path between two anchor points in Illustrator. The
vertical dimensioning (by line) tool works like the
horizontal dimensioning (by line) tool.

Select the vertical dimension (by line) tool and
position the cursor over the line you want to dimen-
sion. When the (      ) cursor appears, click the
vertical line and drag to position the dimension
line. Hold down the shift key while dragging to
offset the vertical dimension line in increments. The
offset increment value is set in the Dimension Line
Preference panel in the CADtools Preferences.

Note: To quickly toggle between vertical dimension
(by line) and horizontal dimension (by line), use the
alt/option key.

first click

○

○

○

○

second click
then drag

first click
then drag

○ ○ ○ ○

Hot Tip!
The CADtips palette displays step-by-step
instructions while you are using any tool
belonging to CADtools.
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Vertical dimension (by points)
The vertical dimension (by points) tool will
dimension the vertical distance between any two
points. You define the location of these two points
anywhere on your document.

Select the vertical dimension (by points) tool and
position the cursor at one end of the vertical dis-
tance you want to dimension. If this is an anchor
point, the cursor will change to (       ). Then click
the mouse button once and release the mouse
button. Position the cursor at the opposite end of
the vertical distance you want to dimension. If this
is an anchor point, the cursor will change to
(       ). Then click and drag to position the dimen-
sion line. Hold down the shift key while dragging to
offset the vertical dimension line in increments. The
offset increment value is set in the Dimension Line
Preference panel in the CADtools Preferences.

Note: To quickly toggle between vertical dimension
(by points) and horizontal dimension (by points),
use the alt/option key.

Inclined dimension (by line)
The inclined dimension (by line) tool will
dimension angled or “inclined” line segments.
A line segment is a straight path between two
anchor points in Illustrator.

Select the inclined dimension (by line) tool and
position the cursor over the inclined line you want
to dimension. When the (      ) cursor appears, click
the line and drag to position the dimension line.
Hold down the shift key while dragging to offset
the inclined dimension line in increments. The
offset increment value is set in the Dimension Line
Preference panel in the CADtools Preferences.

first click

○ ○ ○ ○

second click
then drag

○

○

○

○

first click
then drag
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Inclined dimension (by points)
The inclined dimension (by points) tool will
dimension the absolute distance between any two
points. You define the location of the two points,
which do not have to be 1) on the same line or path
or 2) anchor points on artwork.

Select the inclined dimension (by points) tool and
position the cursor at one end of the inclined dis-
tance you want to dimension. If this is an anchor
point, the cursor will change to (       ). Then click
the mouse button once and release the mouse
button. Position the cursor at the opposite end of
the inclined distance you want to dimension. If this
is an anchor point, the cursor will change to
(      ). Then click and drag to position the dimen-
sion line. Hold down the shift key while dragging to
offset the inclined dimension line in increments. The
offset increment value is set in the Dimension Line
Preference panel in CADtools Preferences.

Section line
The section line tool will allow you to create a
section line on your document. Select the section
line tool and position the cursor where you want
the beginning of the line to appear. Click and drag
to position the line, then release the mouse button
to create the line. Hold down the shift key while
dragging to constrain the tool to multiples of 45°.
Hold down the control key while dragging to
toggle the placement of the section line label.
To automatically double the stroke weight of section
lines, check the option in the Dimension Line
Preference panel in CADtools Preferences.

Center line
The center line tool will allow you to create a center
line on your document. Select the center line tool
and position the cursor where you want the begin-
ning of the line to appear. Click and drag to
position the line, then release the mouse button
to create the line. Hold down the shift key while
dragging to constrain the tool to multiples of 45°.

○

○

○

○

first click

second click
then drag

A

A

first click then drag

○

○

○

○

○

○

○

○

○

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

first click then drag

Hot Tip!
To quickly find the center of a line or shape, use
the circle center tool. Then select the center line
tool, click on the endpoint of the object’s center
symbol, and drag to accurately place your center
line. Make sure you have checked “Allow dimen-
sions off of dimensions” in CADtools Preferences.

Hot Tip!
Create consistently placed linear dimension lines
by holding down the shift key while dragging
dimension lines. This will offset the dimension
lines at an increment set in the Dimension Line
Preference in CADtools Preferences.
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Angle dimension
The angle dimension tool will dimension the angle
between any two nonparallel lines. Position the
cursor over the first line. When the (      ) cursor
appears, click anywhere on the line and release the
mouse button. Then position the cursor over the
second line. When the (      ) cursor appears, click
anywhere on the line and drag to position the angle
dimension line. Hold down the control key while
dragging to dimension the opposite angle. Hold
down the alt/option key while you are dragging to
remove witness lines.

Arc length dimension
The arc length dimension tool will dimension the
length of a circular arc or circle defined by any two
points on the circular arc or circle. Position the
cursor over the arc or circle where the arc length
dimension will begin. When the (      ) or (      )
cursor appears, click once on the arc or circle. Then
position the cursor over the arc or circle where the
arc length dimension will end. When the (      ) or
(      ) cursor appears, click on the arc and drag to
position the arc length dimension line. Hold down
the control key while you are dragging to dimen-
sion the opposite arc length.

Note: The arc length dimension tool works only
on circular arcs or circles.

Square label
To create a square label, select the square label tool
and position the cursor where you want the termi-
nator to end. Click and drag to position the square
label. Hold down the shift key while dragging to
constrain the tool to multiples of 45°. Hold down
the control key while you are dragging to toggle the
placement of the label text.

Note: To edit the text, select the text tool and high-
light the label text. The label artwork can be
selected, moved and modified as needed.

first click

second click
then drag

○

○

○

○

○

first click

first
click

second
click then
drag

○

○

○

○

○

○

○

#

first click then drag
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Circle label
To create a circle label, select the circle label tool
and position the cursor where you want the termi-
nator to end. Click and drag to position the circle
label. Hold down the shift key while dragging to
constrain the tool to multiples of 45°. Hold down
the control key while you are dragging to toggle
the placement of the label text.

Triangle label
To create a triangle label, select the triangle label
tool and position the cursor where you want the
terminator to end. Click and drag to position the
triangle label. Hold down the shift key while drag-
ging to constrain the tool to multiples of 45°. Hold
down the control key while you are dragging to
toggle the placement of the label text.

Pointer label
To create a pointer label, select the pointer label
tool and position the cursor where you want the
terminator to end. Click and drag to position the
pointer label. Hold down the shift key while drag-
ging to constrain the tool to multiples of 45°. Hold
down the control key while you are dragging to
toggle the placement of the label text.

Datum feature
To create a datum feature, select the datum feature
tool and position the cursor where you want the
terminator to end. Click and drag to position the
datum feature. Hold down the shift key while drag-
ging to constrain the tool to multiples of 45°. Hold
down the control key while you are dragging to
toggle the placement of the label text.

Datum target
To create a datum target, select the datum target
tool and position the cursor where you want the
terminator to end. Click and drag to position the
datum target. Hold down the shift key while drag-
ging to constrain the tool to multiples of 45°. Hold
down the control key while you are dragging to
toggle the placement of the label text.

○

○

○

○

#

○

○

○

○

A

○

○

○

○

#

first click then drag

first click then drag

first click then drag
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○

○
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○

○

○
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Datum flag
To create a datum flag, select the datum flag tool
and position the cursor where you want the datum
flag to begin. Click and drag to position the datum
flag. Hold down the shift key while dragging to
constrain the tool to multiples of 45°. Hold down
the control key while you are dragging to toggle
the placement of the flag.

Revision bubble
The revision bubble allows you to automatically
encircle artwork or drag to make revision bubbles
and tree symbols. To automatically encircle objects
with a revision bubble, select the revision bubble
tool and position the cursor over artwork or text
path. Click once to create the bubble. To create
your own revision bubble, position the cursor where
you want a corner of the bubble to appear. Click
and drag from one edge of the bubble to the
opposite edge. Hold down the shift key while
dragging to create a circular revision bubble.

Radius dimension
Select the radius dimension tool and position the
cursor over the path of a circle. When the (      )
cursor appears, click and drag to position the
radius dimension. Hold down the shift key while
dragging to constrain the tool to multiples of 45°.
Hold down the control key while you are dragging
to toggle the placement of the radius dimension
text.

Note: To quickly toggle between radius dimension
and diameter dimension, use the alt/option key.

Diameter dimension
Select the diameter dimension tool and position the
cursor over the path of a circle. When the (      )
cursor appears, click and drag to position the
diameter dimension. Hold down the shift key while
dragging to constrain the tool to multiples of 45°.
Hold down the control key while you are dragging
to toggle the placement of the diameter dimension
text.

Text
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○

○
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Bézier curvature dimension
The Bézier curvature dimension tool will automati-
cally display the radius at any point on a Bézier
curve. Select the Bézier curvature dimension tool
and position the cursor over a Bézier curve. When
the (      ) cursor appears, click and drag along the
Bézier curve. While you are dragging along the
curved path, you will see a radius and its arc at
every point. To create the Bézier curvature dimen-
sion at any point, release the mouse button at that
point. To hide the arc, hold down the control key
while dragging.

Note: Circles and arcs created within Illustrator are
constructed with Bézier curves. The approximation
of their radius may reveal up to 5% difference in
value using the Bézier curvature dimension tool.

Circle center
Select the circle center tool and position the cursor
over the path of a circle. When the (     )  cursor
appears, click once and release the mouse button.

Note: the circle center tool will also allow you
to find the center of the invisible bounding box
enclosing any path.

click once

click then drag
along curve

R

Hot Tip!
Use the circle center tool to find the center of any
shape or path. The center is determined by the
invisible bounding box enclosing the artwork.

Hot Tip!
To dimension type, convert type to outlines with
the Create Outlines command in Adobe
Illustrator.
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Dimensioning imported artwork
CADtools dimensioning tools works with any
vector artwork inside Adobe Illustrator 7.0. If your
imported artwork appears as vector paths, it can
be dimensioned with CADtools. In some cases, an
imported file may contain circles which consist of
a series of line segments. Radius, diameter, arc
length, and Bézier curvature dimensioning tools
will not work for ellipses or arcs which consist of line
segments.

For questions regarding opening, placing, or
exporting files using Illustrator, please refer to the
Adobe Illustrator 7.0 User Guide, technical notes,
and Adobe web site at http://www.adobe.com/

Paint style settings for dimension line
and text
The paint style palette in Adobe Illustrator 7.0
displays the paint attributes of artwork currently
selected – or most recently selected if nothing is
currently selected. If you set the fill and stroke for
dimensioning and then click on artwork with other
attributes, your dimensioning paint attributes will be
replaced by those of the artwork selected.
You can avoid this inconvenience by checking
“Draw dimensions in black” in the Dimension Line
Preferences panel in CADtools Preferences. “Draw
dimensions in black” will ignore the current paint
style settings and allow you to always create black
dimension lines and text. Only stroke weight for
your dimension lines will remain defined by the
settings in the stroke palette.

For stroked dimension text, check “Stroke dimension
text” in the Dimension Terminators Preferences
panel in CADtools Preferences.

If dimension lines appear very thin or disappear
when printed, their stroke weight may be 0 point.
0 point lines may be visible on the screen but not on
the printed page.
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Healing walls
The CADtools wall healer tool unites intersecting
wall paths which are not made of multiple com-
pound paths. If the wall paths are composed of
multiple compound paths, you can heal them using
the Unite filter in Illustrator. To unite, select both wall
paths and choose Object > Pathfinder > Unite.

Drawing in the dimension layer
By checking “Create and use dimension layer”, your
dimensions will automatically draw into a separate
layer named “Dimension Layer”. This layer can be
hidden, locked, displayed, and printed like other
layers created within Illustrator 7.0. If the “Dimen-
sion Layer” is selected – by manually selecting it or
selecting a dimension drawn into that layer – new
artwork will be placed on the “Dimension Layer”. As
a general Illustrator tip, make sure that you are
working in the appropriate layer by checking that it
is selected while you are drawing.

Using grids and guides
CADtools drafting and dimensioning tools do not
snap or respond to Illustrator grids and guides –
which are not artwork. To use CADtools with grids
or guides, create a grid or guide as Illustrator
artwork.

Bézier curvature dimensioning for circles
and circular arcs
Circles and circular arcs created within Illustrator
are constructed with Bézier curves. Therefore, the
radius at any point of a circle or circular arc may
reveal a variance of up to 5% of the original
specified radius. The Bézier curvature dimension
tool will reveal these minute variations. To insure
accurate dimensions of circles, use the
radius or diameter dimension tools.
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Drafting/editing tools
Drawing in scale with info displayed in CADtracker palette

Dimensioning tools
Customizable leaders, lines, terminators, and text placement
in CADtools preferences

ellipse, centered ellipse, arc

rectangle, centered rectangle

fillet, chamfer, trim, wall healer

horizontal dimension (by line), horizontal dimension
(by points), vertical dimension (by line), vertical
dimension (by points), inclined dimension (by line),
inclined dimension (by points), section line, center line

angle dimension, arc length dimension

square label, circle label, triangle label, pointer label,
datum feature, datum target, datum flag, revision bubble

radius dimension, diameter dimension,
Bézier curvature dimension, circle center

line, wall

CADtips:
Smart feedback

CADtracker:
Scale/object info
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A

Angle dimension  24
Append unit labels  11
Arc

(by endpoints)  13
(by radius)  13

Arc Length
(in CADtracker)16
dimension  24

Area in CADtracker  16
Arrowhead style  11

B

Bézier curvature
dimension  27

C

CADtips  4,  6,  30
CADtools Preferences  5,

9-12
CADtracker  6,  16,  30
Center line  23
Centered ellipse  13
Centered rectangle  14
Chamfer

tool  17
offset  12,  17

Circle
with ellipse tools  13
circle center  27
circle label  25

Circumference  16
compound paths  18,  29
Cursor feedback  8
Custom Scale  9

D

Datum feature  25
Datum flag  26
Datum target  25
Diameter  16
Diameter dimension  26
Dimension layer

creating  10
troubleshooting  29

Dimension offset  10

Index

Dimension Terminators  11
Dimension Text  11
Dimensioning tools  19-27
Drafting

tools  13-16
tools Preference  12

E

Ellipse  13

F

FAQ  4
Fillet radius  12
Fillet tool  17

H

H in CADtracker 16
Help  4
Horizontal dimension

(by line)  20
(by points)  21

I

Icons  5
Imported artwork  28
Inclined dimension

(by line)  22
(by points)  23

Installation  2

K

Keyboarding features  7

L

Length in CADtracker 16
Line  14

N

Numeric input  6

P

Paint style  10, 20
Palettes  6, 30
Perimeter  16
Pointer label  25

Index
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Polygons  14
Precision  9

R

Radius  16
Radius dimension  26
Rectangle  14
Registration  3
Revision bubble  26

S

Scale  9
Section line tool  23
Square label  24
Stroke dimension text  11
Stroke weight

for dimensions  20
for section line  10

T

Technical support  4
Terminators  11
Tool reference  30
Triangle label  25
Trim  18

U

Unit
labels  11
numeric input  6
defined  9

V

Vertical dimension
(by line)  21
(by points)  22

W

W in CADtracker  16
Wall  15
Wall healer

tool  18
troubleshooting  29

Wall thickness  12

Witness line extension  10
Witness line gap  10

X

X in CADtracker  16

Y

Y in CADtracker  16
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